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QUICK REFERENCE

Hatch Embroidery uses toolbars and shortcut 
keys to provide quick and easy access to 
common commands. It can be opened via 
the desktop icon or MS Windows® Start menu. 
For a summary of software tools and 
keyboard shortcuts available in Hatch 
Embroidery, refer to the topics below.

Note: The tools and commands described 
here are all available in the highest product 
level. Not all are applicable to other product 
levels.

Menus

The main menu is normally docked at the top 
of the screen above the design window. Use it 
to access common commands. As you get 
more familiar with them, you can speed things 
up using Keyboard shortcuts. Many of these 
commands are also available as toolbar 
buttons. Some may not appear in the list or 
may be inactive depending on the level of 
software you own.

Note: Most standard MS Windows® Alt key 
shortcuts apply. Use the Alt key with the letter 
underlined in the menu. To cancel an 
operation, press Esc twice or click on the Esc 
icon on the toolbar.

File menu

Command Tip

New blank 
design

Create new blank design based 
on default template, fabric and 
background settings. Shortcut 
<Ctrl+N>

New from 
template

Create new design based on 
selected template as well as fabric 
and background settings.

New from 
design

Create new design based on an 
existing design.

Open design Open an existing embroidery 
design from hard disk or network 
drive. Shortcut <Ctrl+O>

Open recent 
design

Open design from a list of recently 
opened designs.

Open backup 
design

Open directly onto the backup 
folder for quick access to backup 
files in case of software failure.

Insert design Import embroidery design files 
into the current design.

Insert artwork Import vector or bitmap artwork 
into current design as backdrop 
for manual or automatic digitizing.

Save design Save current design. Shortcut 
<Ctrl+S>

Save design as Save current design with different 
name, location or format.

Save as 
template

Save current design as design 
template for future use.

Export design Save current design as production 
file for use by machine.

Export cutting Export current design or selected 
objects to SVG file format for 
cutting.

Print preview View worksheets on screen. Print 
worksheets from this window.

Print design Print active design using current 
settings. Shortcut <Ctrl+P>

Command Tip
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Edit menu

Cross Stitch Access the Cross Stitch 
application.

Capture design 
image

Save design image as bitmap 
according to settings in the 
Capture Design Image dialog.

Close design Close current design tab.
Close all 
designs

Close all design tabs.

Sign out and 
release license

Exit program and sign out of Hatch 
account.

Exit program Close all open designs and exit 
program. Shortcut <Alt+F4>

Command Tip

Undo / Redo Standard Windows commands. 
Cancel or re-apply preceding 
command or series of commands. 
Shortcut <Ctrl+Z/Y>

Cut / Copy / 
Paste

Standard Windows commands. 
Cut or copy selection and place on 
Clipboard. Paste contents to 
design window. Shortcut 
<Ctrl+X/C/V>

Duplicate Duplicate selection without 
placing it on clipboard. Shortcut 
<Ctrl+D>

Duplicate with 
offset

Duplicate with preset offset. 
Create regular patterns of 
duplicates. Adjust setting via 
Embroidery Settings > Edit dialog. 
Shortcut <Ctrl+Shift+D>

Delete Delete selection without placing it 
on clipboard. Shortcut <Del>

Select / 
deselect all

Select or deselect all objects in 
current design. Shortcut <Ctrl+A> 
/ <X>

Close shape 
with straight 
line / curved 
line

Close selected open outlines with 
straight or curved line.

Optimize color 
changes

Optimize design by reducing color 
changes to a minimum, while 
maintaining color layers.

Command Tip

Apply closest 
join

Join selected objects at closest 
point. Re-apply closest join after 
editing. Shortcut <J>

Sequence >> Toggle display of Sequence 
docker. Sequence objects and 
color blocks in current design. 
Shortcut <Shift+L>

Sequence by 
selection order

Hold down <Ctrl> and click to 
select objects in current design. 
Select command to sequence 
objects in order of selection.

Break apart Split composite objects – 
monograms, appliqués, lettering, 
etc – into components. Allows 
each to be edited individually. 
Shortcut <Ctrl+K>

Remove color 
change

Remove color changes in 
selected objects which have been 
manually inserted while traveling 
through design.

Regenerate 
stitches

Manually regenerate stitches for 
selected objects. Shortcut <G>

Recognize 
stitches

While machine files are generally 
not suited to modification, the 
software can ‘recognize’ object 
outlines, stitch types and spacing 
from stitch data. After opening a 
machine file, run the Recognize 
Stitches command to recognize 
stitch blocks as objects.

Adjust stitch 
spacing

Manually override stitch densities 
of selected objects or entire 
designs.

Object 
properties >>

Open Object Properties docker to 
preset properties or adjust them 
for selected objects.

Copy object 
properties

Make properties of selected object 
current for the design.

Apply object 
properties

Apply current settings to selected 
objects.

Command Tip
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View menu Arrange menu

Machine menu

Command Tip

TrueView Toggle simulation of stitched 
embroidery. Shortcut <T>

Show design Toggle display of design elements. 
Click to open droplist of view 
settings.

Show hoop Toggle hoop display. Shortcut 
<Shift+H>

Show hoop 
template

Toggle display of hoop template 
as an alternative to grid lines. 
Align design at correct location 
and orientation.

Show grid Toggle grid display. Shortcut 
<Shift+G>

Show rulers Toggle display of rulers and 
guides. Shortcut <Ctrl+R>

Stitch player Simulate embroidery design 
stitchout onscreen in either stitch 
or TrueView. Shortcut <Shift+R>

Measure tool Measure distances and angles on 
screen. Shortcut <M>

Zoom Zoom in/out of workspace and 
zoom in on bounded areas to full 
window size. See also Zoom 
toolbar.

Pan Drag to pan across design at high 
zoom factors. Shortcut <P>

Previous view Return to previous view. Shortcut 
<V>

Center at 
current stitch

Center currently selected stitch in 
design window. Shortcut <C>

Refresh screen Refresh screen display. Shortcut 
<R>

Command Tip

Group Combine multiple objects into one 
selectable object grouping. 
Shortcut <Ctrl+G>

Ungroup Split object grouping into 
component objects. Shortcut 
<Ctrl+U>

Lock Lock selected objects to protect 
them during digitizing or editing. 
Shortcut <K>

Unlock 
selected

Unlock locked objects selected in 
the Sequence docker.

Unlock all Unlock all locked objects in 
design. Shortcut <Shift+K>

View by color View embroidery objects by color.
Hide selected Hide selected object/s from view.
Hide 
unselected

Hide all objects apart from 
currently selected.

Unhide 
selected

Unhide hidden objects selected in 
the Sequence docker.

Unhide all Restore all hidden objects to view.
Align Access commands to align 

selected object tops, bottoms, 
right sides, left sides, etc.

Space Access commands to distribute 
selected objects evenly down or 
across the screen.

Command Tip

Transfer design Transfer current design to preset 
design folder.

Transfer 
settings

Preset file types required by 
selected machines, as well as file 
location on the network or PC.
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Design Settings menu

Software Settings menu

Window menu

Help menu

Refer to the Help menu for the following 
sources of information...

 ‘Release Notes’ and a ‘Quick Start Guide’ 
can be viewed and downloaded via the 
Help menu.

 Follow the link to Product Help to 
download a PDF of the entire Hatch 
Embroidery User Guide.

 A printed copy can also be ordered via 
Product Help.

Command Tip

Design 
information >>

View design information such as 
size and number of stitches. Add 
comments to print on worksheet.

Background 
and display 
colors

Set colors, fabrics, or articles as 
design backgrounds and set 
display colors.

Auto fabric Modify design properties for 
stitchout on different fabric.

Auto start and 
end

Set auto start and end points for 
entire design.

Remove small 
stitches

Control automatic removal of 
small stitches. (Default set to 
‘Always’.)

Object 
properties >>

Open the Object Properties 
docker to preset properties or 
adjust for selected objects.

Command Tip

User interface 
settings

Preset user interface (GUI) 
settings for tools, grids and 
guides, view settings, and 
scrolling options.

Embroidery 
settings

Preset default settings for 
machine file conversion, object 
duplication, overlap removal, 
appliqué, as well as hoop settings.

Manage auto 
fabrics

Create custom fabric settings to 
suit particular needs.

Manage thread 
charts

Create your own charts to 
represent the palette of threads 
you have available. Change code, 
name or chart for existing threads.

Manage motifs If you have created custom motifs, 
you can manage them via this 
command. Rename or delete 
individual motifs or entire custom 
categories.

Manage 
borders

If you have created custom 
borders, manage them via this 
command.

Calibrate 
screen

Calibrate your monitor so that 
designs at 1:1 scale appear at real 
size. Do this when you first install 
the software, whenever you 
change your monitor, or adjust 
your monitor’s horizontal or 
vertical controls.

Scanner setup Set up scanner to interact directly 
with the software.

Customer 
experience 
program

Opt out of the customer 
experience improvement program 
as preferred.

Command Tip

Tile horizontal / 
vertical

Tile design windows with multiple 
designs.

Remove tiling Remove any open tiling.
Dockers Toggle display of dockers.
Toolbars Toggle display of toolbars.

Command Tip

Product help 
available online

Training material and 
courses available from 
Hatch Academy

https://hatch.embroideryhelp.net/v3/en/index.htm
https://hatch.embroideryhelp.net/v3/en/index.htm
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 The Hints docker provides a valuable 
learning resource from within the software. 
It can be activated via the Help menu. 
Each hint includes a brief feature summary 
together with a link to a short video.

 Note that ‘just-in-time’ help for each tool 
can also be accessed via F1 keypress. 
Simply point to the tool and press F1.

 The Help menu also provides access to the 
Hatch Academy. This resource provides 
free and paid online courses from Hatch 
and embroidery experts. Resources 
include embroidery basics, Hatch software 
training and projects.

 Run the Check for updates command to 
check for periodic software updates.

Toolbars

You access commands in your design 
window using toolbar buttons. To activate a 
tool, simply move the mouse pointer over it, 

and click with the left mouse button. Where 
applicable, right-click a tool to access 
settings.

Note: Not all tools and commands are 
applicable to all product levels.

Switch & Convert toolbar

Hatch Embroidery has a single ‘design 
window’ but you interact with it in different 
ways. The main operating modes are 

Follow link for 
details

Download and 
install as 
preferred

https://profile.hatchembroidery.com/?return_url=https://academy.hatchembroidery.com/enrollments
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accessed via the Switch & Convert toolbar. 
See also The user interface.

Design Colors toolbar

You change thread colors for embroidery 
objects from the Design Colors toolbar. This is 
the simplest way to customize a design. The 
design colors you set are saved with the 

current design. See also Design colors (User 
Guide).

Select toolbar

Use the Select toolbar to select or reshape 
objects.

Tool Tip

Home
Revisit the Home screen to 
access tutorials and other 
product information.

Switch to 
Embroidery 
Mode

Digitize and edit embroidery 
designs. Display embroidery 
as well as artwork. View 
designs realistically in 3D 
simulation.

Switch to 
Graphics 
Mode

Import, edit or create vector 
artwork as backdrop for 
embroidery digitizing, manual 
or automatic.

Convert 
embroidery 
to artwork

Convert selected embroidery 
objects to vector artwork.

Convert 
artwork to 
embroidery

Convert selected vector 
artwork to embroidery objects 
in Graphics Mode.

Tag as 
appliqué

Tag selected vectors for 
conversion to appliqué 
embroidery.

Keep 
Graphic 
Objects

When toggled on, artwork will 
be preserved during the 
conversion process.

Match to 
embroidery 
palette

When toggled off, graphic 
colors are added to the 
embroidery design palette. 
When toggled on, graphic 
colors are matched to palette 
colors.

Show 
embroidery

Toggle display of embroidery 
components in Graphics 
Mode.

Design 
Library Open Design Library window.

Tool Tip

Current 
color View current design color.

Pick color Pick a color from design 
window and make it current.

Apply color Apply current color to 
embroidery objects.

Add design 
color

Add color to end of the design 
palette.

Remove 
design color

Remove unused color from 
end of the design palette.

Hide 
unused 
colors

Toggle display of all unused 
colors in the design palette.

Discard 
unused 
colors

Remove all unused colors 
from the design palette.

Threads >>

Toggle display of Threads 
docker. Find threads from 
different charts and change 
design colors. Shortcut 
<Alt+T>

Tool Tip

Select

Select an object or group. Or 
drag selection marquee to 
select multiple enclosed 
objects or groups. Shortcut 
<0>

Polygon 
select

Select an object or group by 
digitizing polygon line around 
them. Shortcut <Ctrl+L>

Reshape
Reshape an object shape, edit 
stitch angles, or adjust entry 
and exit points. Shortcut <H>
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Standard toolbar

Use the Standard toolbar for commonly used 
functions such as opening, saving, and 
printing designs.

Status bar

A Status Bar at the bottom of the design 
window provides continuous display of 
current cursor position status as well as 
instructions for use of selected tools.

Tool Tip

New blank 
design

Create new blank design 
based on default template, 
fabric and background 
settings. Shortcut <Ctrl+N>

New from 
design

Create new design based on 
an existing design.

Open 
design

Open existing embroidery 
design from hard disk or 
network drive. Shortcut 
<Ctrl+O>

Open recent 
design

Open design from list of 
recently opened designs.

Insert 
design

Insert existing embroidery 
design into current design.

Insert 
artwork

Import vector or bitmap 
artwork into current design as 
backdrop for manual or 
automatic digitizing.

Save design Save current design. Shortcut 
<Ctrl+S>

Export 
design

Export current design to 
machine file for stitching.

Transfer 
design

Transfer current design to 
design folder. Right-click for 
settings.

Print design Print current design. Shortcut 
<Ctrl+P>

Print 
preview

Preview worksheets. Print 
from preview window.

Cut Cut the selection and place on 
clipboard. Shortcut <Ctrl+X>

Copy
Copy the selection and place 
on clipboard. Shortcut 
<Ctrl+C>

Paste Paste contents of the 
clipboard. Shortcut <Ctrl+V>

Undo Undo previous action.

Redo Redo previously undone 
action.

Cancel Cancel current process and 
deselect any selected objects.

Tool Tip

Field Notes

Prompt 
message

To guide you through use of selected 
functions.

Design size Width (W) and height (H).

Coordinates
Current needle position (X/Y), and 
length (L) and angle (A) of current 
stitch. See also Design 
measurement.

Stitch count Total number of stitches in design.

Current 
fabric

Fabric settings take into account the 
type of fabric you are stitching on. See 
also Fabrics & densities (User Guide).

Grade of 
design

Native EMB designs are classified in 
four grades depending on how the file 
was created. See Supported 
embroidery files for details.

Field Notes
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Travel toolbar

Use the Travel toolbar for design checking.

View toolbar

Use the View toolbar to set design view 
settings and other commonly used functions. 

Zoom toolbar

Use the Zoom toolbar to zoom and pan across 
designs.

Tool Tip

Select while 
traveling

Toggle on to select stitches, 
objects, or colors while 
traveling through a design. 
Only enabled when Stitch Edit 
tool is activated.

Travel 
backward

Travel backwards through 
design.

Travel 
forward

Travel forwards through 
design.

Jump by 
object

Use in conjunction with 
Forward and Back icons to 
travel to previous or next 
objects.

Jump by 
color

Use in conjunction with 
Forward and Back icons to 
travel to previous or next color 
change.

Jump to 
start/end

Use in conjunction with 
Forward and Back icons to 
travel to start or end of design.

Tool Tip

TrueView Toggle simulation of stitched 
embroidery. Shortcut <T>

Show 
design

Toggle display of design 
elements. Click to open 
droplist of view settings.

Show hoop
Toggle hoop display. 
Right-click for settings. 
Shortcut <Shift+H>

Show hoop 
template Toggle hoop template display.

Show grid
Toggle grid display. Right-click 
for settings. Shortcut 
<Shift+G>

Show rulers 
& guides

Toggle display of rulers and 
guides. Right-click for 
settings. Shortcut <Ctrl+R>

Stitch player
Simulate embroidery design 
stitchout onscreen in either 
stitch or TrueView. Shortcut 
<Shift+R>

Tool Tip

Pan Pan across design at high 
zoom factors. Shortcut <P>

Zoom 1:1 Display design at actual size. 
Shortcut <1>

Zoom in Zoom in for more design detail. 
Shortcut <+>

Zoom out Zoom out for broader view. 
Shortcut <->

Zoom to fit
Display whole design in design 
window. Shortcut <0> (zero)

Zoom Zoom on a specific area of 
design window. Shortcut <B>

Use Zoom Scale to display 
design at a specific scale, or 
zoom to article or hoop.

Tool Tip
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View (Manage Designs) toolbar

The View (Manage Designs) toolbar contains 
functions for quick search, sort, and location 
of designs on your company network.

Context toolbar

Hatch Embroidery includes a Context toolbar 
which changes according to the selected 
tool. If you have no tools selected, you will see 
a custom hoop list. Here you can also change 

hoop settings, rotate hoop, set your 
measurement units – Metric or U.S. – as well as 
adjust screen background settings.

Tool Tip

Layout
Toggle display of navigation 
pane, details pane, and/or 
preview pane.

Design 
information 
>>

View design information such 
as size and number of 
stitches. Add comments to 
print on worksheet.

Keyboard 
Design 
Collection

Toggle display of Keyboard 
Design Collection docker. 
Create, edit and manage 
keyboard design collections.

Change 
view

Change current view of 
design lists.

Reset Detail 
Columns

Reset columns displayed in 
details view to default layout.

Group by
Group current design list by 
selected property and sort 
order.

Sort by
Sort current design list by 
selected property and sort 
order.

Showing Filter current design list by file 
type. 

Search
Filter designs based on 
specified search criteria – e.g. 
stitch range.

Ascending 
order

Sort designs in ascending or 
descending order. 

Descending 
order

Tool Tip
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Design window tools

The following tools are available by default 
with nothing selected.

Digitizing methods

The following tools are available when a 
digitizing method is selected. 

Droplist Tip

Select machine brand 
for current design.

Select from list of 
models or types – single 
or multi-needle – 
associated with selected 
machine brand.

Select from hoop list 
associated with selected 
machine and model or 
type.

Tool Tip

Machine & 
Hoop 
Options

Change machines, set up 
hoop lists, and define 
custom brands and hoops.

Rotate hoop 
left 15°

Rotate first hoop, or 
currently selected hoops in 
multi-hooping mode, to the 
left in 15° increments.

Rotate hoop 
right 15°

Rotate first hoop, or 
currently selected hoops in 
multi-hooping mode, to the 
right in 15° increments.
Rotate by specified amount 
– positive or negative – in 
degrees.

Background 
and display 
colors

Change design 
background and display 
colors.

Laydown 
stitch

Generate light fill to flatten 
the nap of textured fabrics 
like terry toweling or fur for 
subsequent embroidery.

Center all
Center whole design and 
hoop at 0,0 position and 
display in the design 
window.

Measureme
nt units

Change measurement 
units within software 
without changing operating 
system settings.

Tool Tip

Outline Outline closed shapes with 
current line stitch type.

Fill Fill closed shapes with current 
fill stitch type.

Hand stitch
Create hand-stitch effects 
which combine randomized 
stitch length, angle and count.

Feather 
edge

Create rough edges, shading 
effects, or imitate fur and other 
fluffy textures in selected 
objects.

Gradient fill
Create perspective and 
shading effects with stitch 
spacing varying between 
dense and open fill.

Radial fill

Create radial turning stitching 
with various stitch types 
including satin, tatami and 
program splits. Can be applied 
to ring shapes. 

Florentine 
effect

Create custom curve-line 
stitching with single guideline.

Elastic 
embossed 
fill

Create decorative split 
patterns following stitch angles 
and scaled according to object 
width.

Tool Tip
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Object editing tools

The following tools are available when 
embroidery objects are selected. 

Custom object tools

The following tools are not editing tools as 
such but they are only available when an 
existing object is selected. 

Transform tools

The following tools are available when 
embroidery objects are selected. 

Automatic 
corners

Turn automatic corners on or 
off. When on, the corners in 
line objects will be mitred or 
capped automatically 
depending on corner angle. 
Turn on or off by object.

Always 
tie-off & trim

Trim connectors. When turned 
on, connectors will always be 
tied off and trimmed. 
Otherwise, the software will 
decide when to trim.

Underlay
Apply or exclude automatic 
underlays to new or selected 
objects. Right-click for 
settings. Shortcut <U>

Tool Tip

Close 
shape with 
straight line Close an open outline with 

straight or curved line.Close 
shape with 
curved line

Duplicate

Duplicate selection in the 
same position. Duplicate is 
placed at end of stitching 
sequence. Also available via 
Edit menu.

Duplicate 
with offset

Duplicate selection in an offset 
position. Create regular 
patterns of duplicates. 
Right-click for settings. Also 
available via Edit menu.

Delete Delete selection. Shortcut 
<Delete>

Group
Group selection. Also 
available via Arrange menu. 
Shortcut <Ctrl+G>

Tool Tip

Ungroup
Ungroup grouped selection. 
Also available via Arrange 
menu. Shortcut <Ctrl+U>

Laydown 
stitch

Generate light fill to flatten the 
nap of textured fabrics like 
terry toweling or fur for 
subsequent embroidery.

Center all
Center whole design and hoop 
at 0,0 position and display in 
the design window.

Tool Tip

Create 
border

Create custom border pattern 
for future use.

Create motif Create custom motif pattern for 
future use.

Tool Tip

Size +10% Increase size of selected 
objects in 10% increments.

Size -10% Reduce size of selected 
objects in 10% increments.

Mirror X Flip selection horizontally.

Mirror Y Flip selection vertically.

Tool Tip
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Align & space tools

The following tools are available when 
multiple embroidery objects are selected. 

Bitmap crop tools

The following tools are available when bitmap 
artwork is selected. Rotate left 

15°
Rotate selection in 15° 
increments to left.

Rotate right 
15°

Rotate selection in 15° 
increments to right.

Skew
Skew selection by specified 
amount – positive or negative 
– in degrees.

Tool Tip

Align left Align left edges of selected 
objects.

Align 
centers 
vertically

Vertically align centers of 
selected objects.

Align right Align right edges of selected 
objects.

Align top Align top edges of selected 
objects.

Align 
centers 
horizontally

Horizontally align centers of 
selected objects.

Align 
bottom

Align bottom edges of selected 
objects.

Align 
centers

Align centers of selected 
objects.

Space 
evenly 
across

Evenly space 3 or more 
selected objects horizontally.

Space 
evenly 
down

Evenly space 3 or more 
selected objects vertically.

Tool Tip

Tool Tip

Rectangular Crop bitmap to rectangle.

Oval Crop bitmap to oval.

Heart Crop bitmap to heart shape.

Star ‘n’ point Crop bitmap to 4 to 12 point 
star shapes.

Curve Crop bitmap to free curves.
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Toolboxes

Toolboxes are like toolbars in that they 
contain software tools. However, each 
toolbox represents a typical scenario you will 
be engaged in, such as customizing designs 
or editing objects. Some tools may appear in 
more than one scenario. As such, toolboxes 
are organized more or less in order of 
common operations, starting with managing 
your designs.

Note: Not all tools and commands are 
applicable to all product levels.

Manage Designs toolbox

The Manage Designs toolbox provides an 
integrated way to view and organize all your 
embroidery designs.

Tool Tip

New from 
selected

Create new design(s) based 
on selected design(s) and/or 
bitmap(s) from chosen 
template.

Open 
selected

Open design(s) selected in 
Design Library window.

Convert 
selected 
designs

Convert design selected in 
Design Library window into 
different file types.

Transfer 
selected 
design

Transfer selected design to 
default machine folder.

Print 
selected

Print design selected in 
Design Library window.

Print 
selected to 
catalog

Print selected designs to 
catalog.

Export 
design list

Export text or CSV file 
containing list of visible design 
files and their properties.

Manage 
embroidery 
library 
locations

Add or remove existing folders 
to/from Design Library, 
enabling fast searching and 
filtering.
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Customize Design toolbox

The Customize Design toolbox provides 
functions which allow you to make global 
adjustments to your designs.

Lettering / Monogramming toolbox

The Lettering / Monogramming toolbox 
provides the tools needed to add high quality 
embroidery lettering to your designs as well as 
create monogram designs.

Artwork toolbox

The Artwork toolbox provides for importing 
electronic artwork into your embroidery 

Tool Tip

Design 
information 
>>

View design information such 
as size and number of 
stitches. Add comments to 
print on worksheet.

Background 
and display 
colors

Change design background 
and display colors.

Machine & 
Hoop 
Options

View machine settings and set 
up custom machine formats. 
Also view hoop settings and 
set up custom hoop lists.

Auto fabric Change properties of design 
for stitching on different fabric.

Auto start 
and end

Set auto start and end points 
for entire design.

Adjust stitch 
spacing

Manually override stitch 
densities for selected objects.

Select 
thread 
charts

Select factory or custom 
thread charts to use in 
Threads list.

Threads >>
Toggle display of Threads 
docker. Find threads from 
different charts and change 
design colors.

Match all 
design 
colors

Automatically match and 
assign threads in thread list to 
all colors in the Design Colors 
toolbar.

Insert 
design

Insert an existing embroidery 
design into current design.

Cycle used 
colors

Cycle through combinations of 
used colors. Left- or right-click.

Color wheel Test combinations of related 
colors.

Optimize 
color 
changes

Optimize design by reducing 
color changes to a minimum, 
while maintaining color layers.

Tool Tip

Lettering >>

Create embroidery lettering 
using embroidery alphabets, 
Keyboard Design Collections 
or TrueType fonts, or edit 
selected lettering. Shortcut 
<A>

Monogram
ming >>

Create personalized 
monograms using selection of 
predefined styles, border 
shapes and ornaments.

Reshape
Reshape an object shape, edit 
stitch angles, or adjust entry 
and exit points. Shortcut <H>

Break apart

Split composite objects – 
monograms, appliqués, 
lettering, etc – into 
components. Allows each to 
be edited individually. Shortcut 
<Ctrl+K>

Knife
Cut objects along digitized 
line, preserving stitch settings 
and colors.

Laydown 
stitch

Generate light fill to flatten the 
nap of textured fabrics like 
terry toweling or fur for 
subsequent embroidery.
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software, editing it, and preparing it for 
automatic digitizing.

Auto-Digitize toolbox

The Auto-Digitize toolbox provides tools for 
the automatic digitizing of prepared artwork 
and photos.Tool Tip

Insert 
artwork

Import vector or bitmap 
artwork into current design as 
backdrop for manual or 
automatic digitizing.

Scan 
artwork

Scan artwork directly from an 
attached scanner into current 
design window.

Adjust 
bitmap

Adjust selected bitmap in 
effect, brightness and 
contrast.

Edit artwork
Edit bitmap artwork in 
preferred graphics application. 
(Preset in User Interface 
Settings > General tab.)

Prepare 
artwork for 
embroidery

Prepare selected bitmap 
artwork for automatic 
digitizing.

Save 
artwork

Save currently selected 
bitmap artwork.

Dim artwork
Dim graphic backdrops to 
show stitches more clearly 
when digitizing.

Lock
Lock selected objects into 
position for protection. 
Shortcut <K>

Unlock all
Unlock all locked objects to 
remove protection. Shortcut 
<Shift+K>

Tool Tip

Insert artwork
Import vector or bitmap 
artwork into current design 
as backdrop for manual or 
automatic digitizing.

Auto-digitize 
instant 
embroidery

Automatically digitize 
whole embroidery design 
directly from imported 
bitmap artwork.

Auto-digitize 
embroidery

Automatically digitize 
prepared bitmap artwork, 
optionally with user’s 
choices.

Color 
PhotoStitch

Automatically turn 
grayscale or color 
photographs into 
embroidery.

Reef 
PhotoStitch

Turn photographs into 
single embroidery field 
resembling coral reef. 
Depending on Automatic 
Trim settings, multiple 
objects may be created.

PhotoFlash >>

Create rows of PhotoSatin 
stitching of varying spacing 
in current color for selected 
photos or other bitmap 
artwork.

Click-to-fill
Digitize large artwork 
shapes with tatami fill, 
preserving any holes 
within.

Click-to-fill 
without holes

Digitize large artwork 
shapes with tatami fill, 
ignoring any holes within.

Click-to-turning 
fill

Digitize narrow column 
artwork shapes with satin 
stitch.

Click-to-outline
Digitize boundaries of 
shapes with run stitching 
using current properties.
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Edit Objects toolbox

The Edit Objects toolbox provides many tools 
for reshaping, resizing, rotating objects, as well 
as add or remove stitch angles.

Click-to-centerli
ne

Digitize centerlines in 
artwork with run stitching 
using current properties.

Smooth shapes
Remove excess 
reshape-nodes from 
selected embroidery 
objects.

Color matching 
method

Select matching method: a) 
add image colors to color 
palette for manual thread 
matching, b) add closest 
matches from selected 
thread charts, or c) use 
closest matches from the 
color palette.

Tool Tip

Object 
properties 
>>

Toggle display of Object 
Properties docker. Preset 
properties for new embroidery 
objects or adjust properties for 
selected embroidery objects.

Copy object 
properties

Make properties of selected 
object current for design.

Apply object 
properties

Apply current settings to 
selected objects.

Adjust stitch 
spacing

Manually override stitch 
densities for selected objects.

Smooth 
shapes

Remove excess 
reshape-nodes from selected 
embroidery objects.

Reshape
Reshape an object shape, edit 
stitch angles, or adjust entry 
and exit points. Shortcut <H>

Add stitch 
angles

Add stitch angles to selected 
filled or lettering object.

Remove 
stitch 
angles

Remove stitch angles from 
closed objects with turning 
stitches.

Tool Tip

Knife
Cut objects along digitized 
line, preserving stitch settings 
and colors.

Weld
Merge selected overlapping 
objects into single ‘flattened’ 
object.

Break apart

Split composite objects – 
monograms, appliqués, 
lettering, etc – into 
components. Allows each to 
be edited individually. Shortcut 
<Ctrl+K>

Remove 
overlaps

Remove stitches that are 
covered by the selected 
objects. Overlap value can be 
changed in the Overlap tab of 
Embroidery Settings dialog.

Create color 
blend

Generate color blends, 
perspective effects and 
shading in selected objects.

Branching
Automatically sequence and 
group selected embroidery 
objects. Shortcut <I>

Redwork

Automatically sequence and 
group selected embroidery 
objects to create Redwork 
object with entry and exit 
points at same position. 
Shortcut <Ctrl+I>

Apply 
closest join

Join selected objects at 
closest point. Re-apply closest 
join after editing. Shortcut <J>

Sequence 
>>

Open Sequence docker. Click 
again to close. Also available 
via Windows > Dockers menu. 
Shortcut <Shift+L>

Sequence 
by selection 
order

Resequence objects in order 
of selection. Hold down <Ctrl> 
and click to select.

Stitch edit

Select individual or multiple 
stitches by clicking needle 
points holding <Ctrl> or 
<Shift>, or dragging selection 
marquee around them. Insert 
stitches at current stitch cursor 
position, and move or delete 
selected stitches. Shortcut 
<E>

Tool Tip
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Digitize toolbox

The Digitize toolbox provides all the digitizing 
tools necessary to create embroidered 
shapes. See also Digitize Objects (User Guide).

Appliqué toolbox

The Appliqué toolbox provides an easy way to 
create all the stitching you need for most 

Tool Tip

Rectangle / 
square

Click two corners of rectangle, 
or press <Ctrl> for square.

Circle / oval
Click center point plus two size 
points for an oval, or press 
<Ctrl> for circle.

Standard 
shapes

Digitize standard shapes. 
Press <Ctrl> to keep 
proportions of the shape. 
Press <Shift> to center at first 
point entered.

Freehand 
open shape

Click and hold to draw 
freehand open shapes. Adjust 
smoothing control for 
preferred result.

Freehand 
closed 
shape

Click and hold to draw 
freehand closed shapes. 
Adjust smoothing control for 
preferred result.

Digitize 
open shape

Digitize open shapes with left 
and right mouse clicks for 
straight lines and curves. 
Shortcut <Shift+N>

Digitize 
closed 
shape

Digitize closed shapes with left 
and right mouse clicks for 
straight lines and curves.

Digitize 
blocks

Digitize column shapes of 
varying width, setting stitch 
angle at each pair of points.

Carving 
stamp >>

Toggle display of Carving 
Stamp docker. Create needle 
penetrations with a ‘carving 
stamp’ as template.

Motif stamp

Add motifs to design 
one-by-one. Rotate, scale with 
<Shift>, or mirror with 
right-click as you add, or press 
<Enter> to accept default 
position and settings. Press 
Esc to stop adding motifs.

Add stitch 
angles

Add stitch angles to selected 
filled or lettering object.

Remove 
stitch 
angles

Remove stitch angles from 
closed objects with turning 
stitches.

Digitize 
holes

Digitize holes in selected filled 
object.

Fill holes

Fill holes via creating new 
objects based on hole 
boundaries of selected object 
with current fill stitch type. 
Right-click for settings.

Remove 
holes

Remove holes from selected 
object.

Weld
Merge selected overlapping 
objects into single ‘flattened’ 
object.

Backtrack
Reinforce an outline, stitching 
it in reverse direction to the 
original. Shortcut <Ctrl+B>

Repeat
Duplicate an outline in same 
direction. Normally used with 
closed shapes.

Branching
Automatically sequence and 
group selected embroidery 
objects. Shortcut <I>

Redwork

Automatically sequence and 
group selected embroidery 
objects to create Redwork 
object with entry and exit 
points at same position. 
Shortcut <Ctrl+I>

Tool Tip
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simple appliqué work. See also Appliqué (User 
Guide).

Create Layouts toolbox

The Create Layouts toolbox lets you easily 
combine designs and design elements by 

inserting the contents of one file into another. 
See also Design Layouts (User Guide).

Tool Tip

Frame-out 
options

Access frame-out options in 
Appliqué tab of Embroidery 
Settings dialog.

Convert to 
appliqué

Convert selected closed 
objects into individual 
appliqués.

Digitize 
appliqué >>

Show Appliqué tab of Object 
Properties docker. Digitize 
appliqué objects with up to 
four layers of stitching – 
placement line, cutting line, 
tack stitches, and cover 
stitches.

Digitize 
appliqué 
with holes 
>>

Show Appliqué tab of Object 
Properties docker. Digitize 
appliqué objects with holes 
with up to four layers of 
stitching – placement line, 
cutting line, tack stitches, and 
cover stitches.

Remove 
overlaps

Remove stitches that are 
covered by selected objects. 
Overlap value can be changed 
in Overlap tab of Embroidery 
Settings dialog.

Partial 
appliqué

Remove unwanted cover 
stitching from underlying 
appliqué objects.

Combine 
appliqué

Break apart appliqué into 
component objects and 
recombine and resequence for 
efficient stitchout.

Break apart

Split composite objects – 
monograms, appliqués, 
lettering, etc – into 
components. Allows each to 
be edited individually. This tool 
is also available via Edit menu. 
Shortcut <Ctrl+K>

Tool Tip

Insert 
design

Insert an existing embroidery 
design into current design.

Mirror-copy 
horizontal

Mirror and copy selected 
objects horizontally.

Mirror-copy 
vertical

Mirror and copy selected 
objects vertically.

Mirror-copy 
both

Mirror and copy selected 
objects around a center point.

Copy array

Duplicate designs, such as 
badges, automatically 
resequencing color blocks for 
efficient multiple design 
stitchouts.

Copy reflect
Duplicate and mirror objects or 
designs. Create decorative 
borders.

Circle layout

Duplicate selected objects 
around a center point. Specify 
how many copies and if 
alternate copies are mirrored 
in Context toolbar.

Define work 
area

Define shape, size, color and 
view of the work area. Shortcut 
<Ctrl+W>

Mirror-copy 
to work area

Automatically mirror and copy 
selected object/s around 
center (0,0) of the work area.

Circle layout 
to work area

Automatically create copies of 
selected object/s (specified by 
Number of Copies in Context 
toolbar) around center of the 
work area.

Auto center 
to work area

Automatically move selected 
object/s to center of the work 
area (0,0).

Buttonholes 
>>

Show Buttonholes tab of 
Object Properties docker. Use 
Place Buttonholes to place a 
string of buttonholes with all 
necessary stitching.



Quick  Reference 19

Multi-Hooping toolbox

If your embroidery is too large or contains a 
number of designs spaced around an article, 
you can use the Multi-Hooping toolbox to split 
it into multiple hoopings.

Output Design toolbox

Using the Output Design toolbox you can 
output embroidery designs in a variety of 
ways – by printing as worksheets, as appliqué 
patterns, color sequence, or as thread charts. 
Hatch Embroidery also allows you to save your 
designs as images for use with fabric and 
garment applications. You can also send 
them directly to machine for stitching. When 
working with designs that are larger than the 
available physical hoop, you can split them 
into parts, each containing an object or 
group of objects. Hatch Embroidery 

Ambience 
quilting Create ‘echo’ quilting blocks.

Create 
outlines & 
offsets

Create outlines and offsets for 
selected embroidery object(s).

Create 
trapunto 
outlines

Use in conjunction with Raised 
Satin to create stitching for a 
raised ‘quilted’ look.

Laydown 
stitch

Generate light fill to flatten the 
nap of textured fabrics like 
terry toweling or fur for 
subsequent embroidery.

Basting 
stitch 
marker

Insert reference marker at any 
angle and position.

Insert 
graphic 
marker

Insert graphic marker 
representing adhesive stickers 
attached to fabric to indicate 
location and orientation.

Tool Tip

Multi-hooping 
options

Change multi-hooping 
options in Multi-Hooping tab 
of the Embroidery Settings 
dialog.

Automatically 
add hoops

Add hoops automatically to 
cover entire design.

Add splitting 
line

Digitize one or more guides 
in multi-hoop layout to split 
objects between hoopings.

Preview 
hoopings

Calculate object distribution 
and registration marks for 
given hoop positions and 
display hooping thumbnails 
in docker. Click hooping 
thumbnail in the docker to 
view in the design window.

Calculate 
hoopings

Calculate hoopings that will 
result from current layout.

Tool Tip

Add hoop Add new hoop to multi-hoop 
layout.

Delete hoop Remove selected hoop from 
multi-hoop layout.

Add hoop 
right

Place new hoop position to 
right of selected hoop. Allow 
10mm overlap between 
sewing fields.

Add hoop left
Place new hoop position to 
left of selected hoop. Allow 
10mm overlap between 
sewing fields.

Add hoop 
down

Place new hoop below 
selected hoop. Allows 10mm 
overlap between sewing 
fields.

Add hoop up
Place new hoop position 
above selected hoop. Allows 
10mm overlap between 
sewing fields.

Add 4 hoops 
around

Place four hoops around 
selected hoop’s perimeter. 
Allows 10mm overlap 
between sewing fields.

Add 8 hoops 
around

Place eight hoops around 
selected hoop’s perimeter. 
Allows 10mm overlap 
between sewing fields.

Tool Tip
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automatically calculates which files are to be 
sent and shows you how they will look.

Tool Tip

Auto start & 
end

Set auto start and end points 
for entire design.

Save design 
as

Save current EMB design with 
different name or location.

Export 
design

Export current design to 
machine file for stitching.

Export 
cutting

Export current design or 
selected objects to SVG file 
format for cutting.

Transfer 
design

Transfer current design to 
preset design folder. 
Right-click for settings.

Print 
preview

Preview worksheets. Print 
from preview window.

Print design Print current design. Shortcut 
<Ctrl+P>

Capture 
design 
image

Save design image as bitmap 
exactly as it appears on 
screen.
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KEYBOARD SHORTCUTS

Hatch Embroidery uses toolbars and shortcut 
keys to provide quick and easy access to 
common commands. This section provides a 
list of all keyboard shortcuts available in Hatch 
Embroidery. Not all shortcuts are applicable 
to all product levels.

Tip: In addition to shortcut keys, standard 
MS Windows® Alt key shortcuts apply to menu 
commands. Use the Alt key in combination 
with letters underlined in the menus. For 
example, press Alt+F+O to access the Open 
Design command in the File menu.

General functions

Selection functions

To... Press...

Activate ‘Digitize Open Shape’ 
and open Outline tab ^ <Shift+N>

Activate Lettering and open 
Lettering docker <A>

Apply/select satin <Shift+I>
Apply/select tatami fill <Shift+M>
Create new design <Ctrl+N>
Close software <Alt+F4>
Define layout work area ^ <Ctrl+W>
Export machine file ^ <Shift+E>
Open an existing design ^ <Ctrl+O>
Print design ^ <Ctrl+P>
Save design ^ <Ctrl+S>
Toggle Design Colors toolbar <Ctrl+Shift+R>
Toggle Design Information 
docker <Alt+P>

Toggle grid <Shift+G>

^ Press <Esc> to cancel command

Toggle rulers <Ctrl+R>
Toggle Design Overview 
window <Shift+V>

Toggle Sequence docker <Shift+L>
Toggle Threads docker <Alt+T>
Toggle work area <W>

To... Press...

Add next object to selection <Ctrl+Tab>
Add previous object to 
selection <Ctrl+Shift+Tab>

Choose Select tool ^ <O>
Deselect all objects <Esc> or <X>

Select range of objects ^
<Shift>+left-click 
first and last 
objects

Select all objects ^ <Ctrl+A>
Select multiple objects ^ <Ctrl>+left-click
Select component within 
grouped object ^ <Alt>+left-click

Select underlying object ^ <2>+left-click
Select next object ^ <Tab>
Select previous object ^ <Shift+Tab>

^ Press <Esc> to cancel command

To... Press...

^ Press <Esc> to cancel command
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Viewing functions

Zoom functions

Travel functions

Editing functions

To... Press...

Center at current stitch <C>
Measure distance on screen ^ <M>
Refresh screen display <R>
Previous view <V>
Toggle connectors <Shift+C>
Toggle function symbols <Shift+F>
Toggle hoop <Shift+H>
Toggle images <D>
Toggle needle points <.> (period)
Toggle shapes <L>
Toggle Stitch Player <Shift+R>
Toggle stitches <S>
Toggle unselected <Shift+S>
Toggle vectors <Shift+D>
Toggle TrueView <T>
View by color <Alt+C>
Zoom box in Overview window <Shift+B>
Zoom to article <Ctrl+0>

^ Press <Esc> to cancel command

To... Press...

Pan ^ <P>
Zoom <B>
Zoom 1:1 <1>
Zoom in 1.25x <+>
Zoom out 1.25x <->
Zoom in 2x <Z>
Zoom out 2x <Shift+Z>
Zoom to fit <0> (zero)

^ Press <Esc> to cancel command

Zoom to hoop </>
Zoom to selected <Shift+0> (zero)
Zoom factor ^ <F>

To travel... Keyboard † Keypad ‡

To start of design <Home> <7>
To end of design <End> <1>
To next color <PgDn> <3>
To previous color <PgUp> <9>
To next object <Ctrl+T>
To previous object <Shift+T>
100 stitches forward <+>
100 stitches backward <->
10 stitches forward ˅ <2>
10 stitches backward ˄ <8>
1 stitch forward > <6>
1 stitch backward < <4>

† Press <Esc> first ‡ Num Lock OFF

To... Press...

Add stitch angles ^ <Ctrl+H>
Apply closest join to selected 
objects <J>

Apply Redwork to selected 
objects ^ <Ctrl+I>

Break apart composite objects <Ctrl+K>
Copy selected objects <Ctrl+C>
Cut selected objects <Ctrl+X>
Delete last reference point 
(when digitizing) <Bksp>

^ Press <Esc> to cancel command

To... Press...

^ Press <Esc> to cancel command
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Digitizing functions

Delete selected objects <Delete>
Duplicate selected objects <Ctrl+D>
Duplicate selected objects with 
offset <Ctrl+Shift+D>

Generate stitches for selected 
objects. <G>

Group selected objects <Ctrl+G>
Lock selected objects <K>
Mirror horizontally <Ctrl+1>
Mirror vertically <Alt+1>

Nudge selected objects Left-click+arrow 
keys

Paste selected objects <Ctrl+V>
Redo command <Ctrl+Y>
Remove overlaps <Ctrl+Shift+E>
Reshape selected objects ^ <H>
Toggle ‘Select While Traveling’ 
(Stitch Edit mode) <Q>

Toggle underlay of selected 
objects <U>

Undo command <Ctrl+Z>
Ungroup selected objects <Ctrl+U>
Unlock all <Shift+K>

To... Press...

Create outlines and offsets ^ <Ctrl+Shift+O>
Digitize appliqué ^ <F7>
Toggle Auto Scroll <Ctrl+Shift+A>
Deactivate (temporarily) Auto 
Scroll <Alt> (hold)

^ Press <Esc> to cancel command

To... Press...

^ Press <Esc> to cancel command
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